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Welcome To Operator Console 

Welcome 

Welcome to the TalkMaster FOCUS Operator Console. The Operator Console is designed to work with 
the  TalkMaster FOCUS Enterprise and Solo  Edition Server and ii3/IP7 IP Intercoms/Paging Endpoints 
from Digital Acoustics, LLC. 

If upgrading from an earlier version, please see the Release Notes topic. 

For an overview of Operator Console, please see the Operator Console Overview topic. 

Release Notes 

Version 6.0- Release June 2018 

 Added menu option Search --> Search IP Endpoint List and keyboard equivalent ctrl+f

 If an Operator tries to answer a call and the "Your Call Is Being Connected" message is still
playing, the Operator Console will wait for it to complete instead of displaying the "Intercom In
Use or Not Available" warning message

Version 5.2.6 - Release April 2018 

 Added updated RTSP Viewer drivers for the TalkMaster Video licensed product to include H.265
camera support

Version 5.2.5 - Release January 2018 

 Corrected an issue where pressing the CHIME button followed by the TALK button would
generate an Incoming Call

 Corrected an issue where after acknowledging the error message “Intercom in use or not
available” for a Full-Duplex IP Endpoint, the message would keep being displayed

 Corrected an issue where an Operator could change to the Paging tab while listening to an IP
Endpoint on the Intercoms tab which caused the error “Cannot listen to a group of speakers” to
be displayed

 Corrected an issue where after stopping a Repeating Message to a Paging Group, the Paging
Group would sometimes be unavailable afterwards
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Version 5.2 - Release June 2016 

 Fixed an issue where answering a call on an IP Endpoint that's TALK button was still engaged
would cause the Operator Console to crash

 On the Intercoms tab, the Play File button and the Talk Mode radio buttons have been
deprecated.  They can be re-enabled in the Preferences - Layout tab, but users are encouraged
to use the Paging Groups tab to play server based Messages

 Added an option to Preferences - Main to Disable keyboard interface on Call Announce
dialog.  This prevents an operator from accidently answering a call while using the keyboard
when the Call Announce dialog is presented

Version 5.1 - Release September 2015 

 Added Associated and Monitored Video as Licensed Options.  Associated streaming video is
configured in TMAC, and those video streams can be “associated” with an IP7 endpoint to be
shown when that endpoint is used in TMOC.  Monitored streams are configured in TMOC and are
selected from available video sources that are defined in TMAC.

Version 4.1 - Released December 2013 

 Help->About shows license information.

Version 4.0 - Released December 2012 

 The Operator Console has been enhanced with Fail Forward.  If the connection between the
Console and the TalkMaster FOCUS Server is broken, the Operator Console can automatically
"fail forward" to a backup TalkMaster FOCUS Server.  Refer to Console Fail Forward Overview
for more information.

 The Operator Console has been enhanced to Monitor (listen to) multiple IP7 endpoints. Refer to
the Monitoring Overview for more information.

 The Background Music toggle has been added to the Intercoms tab as an optional field.  Refer to
the Intercom List topic for more information.

 The columns displayed on the Intercoms tab can be controlled by the Preferences --> Layout
tab.

 The Operator Console now uses the uLaw codec for all microphone options, so the Use uLaw
option has been removed from the Preferences --> Audio and Volume tab.

 An Operator can be configured to logon on to multiple consoles at the same time. Refer the
Admin Console --> Operators tab.

Version 3.0 - Released January 2012 

 The Operator Console now has the ability to send and receive audio to and from the TalkMaster
FOCUS Server using the RTP Protocol (commands are still sent via TCP). RTP is the default
setting for new installs. To specify the option for selecting RTP or TCP for audio between the
TalkMaster FOCUS Server and Operator Console, refer to the Logon topic.

 The Incoming Call announcement can now be specified to play on a different audio device than
the one being used for Talk/Listen operations. This enables the Operator to use a Headset for
talking and listening to a IP Endpoint but have the Incoming Call announcement play on a
separate speaker. Refer to the Preferences - Audio and Volume topic for details.
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 For Half-Duplex options, mouse clicks and keystrokes associated with the Talk/Listen buttons are
buffered to prevent them from being missed.

 The Operator Console has been enhanced to communicate with full-duplex IP7 endpoints. Refer
to the Duplex Options topic for details.

 The Groups tab has been renamed to the Paging Groups tab.

 Paging Group can now be defined with one of three delivery options:

 The Send immediately to available option starts playing the live or pre-recorded
Message immediately.

 The Queued – When some are available option records microphone audio, then
attempts to play the recorded or pre-recorded audio as soon as one or more IP Endpoints
allocated to Group are available.

 The Queued - When all are available option records microphone audio, then attempts to
play the recorded or pre-recorded audio as soon as all IP Endpoints allocated to the
Group become available before the audio starts playing.

 A pre-recorded audio Message can now be created with the Message Repeats until Stopped
option. These messages can be selected in the Operator Console and sent to a non-Queued
Paging Group. Once the repeating message has been started, it will not stop till the Operator
ends the operation.

 The slider for the IP Endpoint Volume Control has been replaced with a drop down box where the
exact volume setting can be chosen.

Version 2.0.2 - Released December 2010 

 Prevented selection of other options while a Group Message was being played.

 Fixed an "Intercom in Use" issue caused by the "Console Refresh" command being run while an
Intercom call is on Hold.

 Fix for trying to end call  before finishing TALK.

Version 2.0 - Released October 2009 

 Added a new Groups tab that allows an Operator to select a pre-defined Group and send them a
pre-defined audio Message.

 Added the ability to sort on the Status column in the Intercoms tab in addition to the Location,
Queue and IP Address.

 Added support to Call an Intercom with the HS-x1 Handset installed.

 Removed the option to display the System Events window.

 Corrected miscellaneous errors.

Version 1.4 - Releases June 2008 

 Added the ability for Operators with ADMIN rights to set Intercom/Paging Endpoint Volume.
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 Added the Release button to allow Operator Console to communicate with Intercoms that have
the Remote Listen Disable option set.

 Added the ability for the Operator Console to automatically log back in if the connection to the
Server is interrupted or if the Server is restarted.

 Added support to receive uLaw audio from IP7 devices. Please review the Preferences - Audio
and Volume topic.

 Added support for the IP7 Sensor option that monitors the status of a door. Please review the
Door/Gate topic under the Intercom List.

 Added an option to the Tools menu to open the folder where support information is stored.

 Added the status of "In Use" for Intercoms placed on Hold. Please review the Calls Waiting List
topic.

 Changed the Preferences option Hide when minimized to Minimize to System Tray on Close
(X). On new installations, this option is not selected.

 Added localization support for English, French, Italian, German, Spanish and Portuguese
languages. The system uses the Windows Control Panel - -> Regional and Languages
Options setting to determine which language to use.

Version 1.3 - Released April 2007 

 Enabled mouse and keyboard selection in the main Intercom List.

 Added Shift Key - Click support to check the Grp box on multiple rows.

 Added the ability to click the Grp column heading to clear or select the Grp box on all connected
Intercoms.

 Enabled the Wheel Mouse scrolling in Intercom List.

 Improved program speed when enabling the menu option "Tools - Record program events to file".

 Corrected miscellaneous errors.

Version 1.2 - Released October 2006 

 Changed format of Microphone audio from PCM to uLAW to improve audio at the Intercom.

 Added support for Intercom option - "Call Button".

 Added the ability to use the Enter key to activate the Door Open icon for a selected Intercom.

 Allow a Group page even if one or more intercoms within the group are currently busy.

 When answering a call from an Intercom that is no longer in Overflow status, the Intercom will
remain in the Intercom List until the call is completed.

 Enabled Up and Down Cursor keys in the Calls Waiting list.

 Changed temporary Call Queue location to the user's Local Settings\Temp sub-directory.
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 Corrected Intercom Error Handling routines.

 Corrected miscellaneous errors.

Version 1.0 - Released November 2005 

 Initial Release

System Requirements 

The minimum requirements* to run Operator Console are: 

 Windows 7, Windows 8.1, Windows 10, Windows Server 2012 or Windows Server 2016.

 2 gigahertz (GHz) or faster 32-bit (x86) or 64-bit (x64) processor.

 At least 2GB RAM (32bit) or 4GB RAM (64bit) for single concurrent end point support.

 20 MB Available Disk space.

 Windows supported Sound Card with headset or  microphone and speakers.

* These are minimum requirements.  As systems grow in size and complexity, more resources are
required.

Operator Console Overview 

Operator Console is the component of the TalkMaster FOCUS Solo or Enterprise Edition system that 
allows an Operator to communicate with users at IP Intercom and Paging Endpoints. Operator Consoles 
and IP Intercoms are both configured to connect to the Server. The Server takes care of connecting 
Intercoms/Paging Endpoints to the proper Consoles based on rules configured through the Admin 
Console. 

Operators can carry out 2-way audio conversations with an IP Endpoint and can send 1-way audio pages 
to one or more IP Intercoms/Paging Endpoints.  

Multiple Operators can manage logical groups of Intercoms/Paging Endpoints called Queues. When an 
Intercom's button is pressed, the Server will place an entry in the Calls Waiting list of all operator 
consoles that are currently managing the Intercom's Queue. The first operator console to respond will 
interact with that intercom for the duration of the call. During that time, the intercom will be unavailable to 
the other Operator Consoles. 

When the amount of calls exceeds the defined service level of a Queue, a call queue is put in Overflow 
status automatically directing unanswered calls to additional operator consoles. Each Operator can 
manage one or more Primary Queues and/or Overflow Intercoms. 

Depending on the hardware used, 2-way audio sessions can use either half-duplex or full-duplex audio. 
 Refer to the following topics for an overview of full-duplex and half-duplex 2-way audio sessions: 

 Full-Duplex Audio Session

 Half-Duplex Audio Session

Operators can also send 1-way audio pages to pre-defined Groups of Intercoms/Paging Endpoints.  The 
Operator can use the PC's microphone to do a live or queued page or can send pre-recorded Messages 
that are associated with the selected Paging Group. Refer to the following topics for an overview of 
sending live or pre-recorded audio to a Paging Group: 
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 Sample Paging Session using a Microphone

 Sample Paging Session using a Pre-Recorded Message

With additional licensing of TalkMaster FOCUS Vision, RTSP video sources can be monitored or 
associated with IP end points, and displayed while the operator is interacting with the endpoint.  Adequate 
network bandwidth and connectivity between TMOC and the video source must be available and 
maintained in order to ensure reliable video streaming performance.  Video source definitions are 
configured in TalkMaster FOCUS Administration Console (TMAC).  

Console Fail Forward Overview 

The Console Fail Forward feature can be used along with the IP Endpoint Fail Forward feature to 
provide redundancy for critical Intercom and Paging Endpoint communications. 

Digital Acoustics' Fail Forward technology recognizes when Operator Consoles and IP Endpoints have 
lost connection to the Primary TalkMaster FOCUS Server.  The Operator Console and the IP Endpoints 
then automatically connect to a backup TalkMaster FOCUS Server to restore communications.  The IP 
Endpoints and Operator Consoles can optionally be set to automatically reconnect to the Primary 
TalkMaster FOCUS Server when it becomes available. 

If connection with the Primary TalkMaster FOCUS Server is lost: 

 The Operator Console will automatically attempt to retry the Logon to the Primary Server

 If the Primary Server still cannot be reached, the Operator Console will attempt to Logon to a Fail
Forward server (up to three can be specified). If the Operator Console is unable to Logon to one
of the Servers, it will wait 10 seconds, then will continue to retry logging on till the Primary or a
Fail Forward Server has been reached

 Once the Operator Console has logged on to a Fail Forward Server, any IP Endpoints that have
been configured to connect to the same Fail Forward server should appear in the Intercom List *

 The IP Address of the connected Server is displayed at the bottom of the Operator Console
display

 If the Automatically Return To Primary Address option has been selected, the Operator
Console will begin checking for the Primary Server after being connected to a Fail Forward server
for 60 seconds

 If the Automatically Return To Primary Address option has not been selected, manual
intervention is required to have the Operator Console log back onto the Primary Server when it is
available:

 The Operator can log off, then log back on to the Primary Server

 An administrator can restart the Fail Forward Server which will force the Operator
Console to automatically retry logging in to the Primary Server

To setup the Console Fail Forward feature, refer to the Logon or the Preferences - Connections 
dialog. 

To setup the IP Enpdpoint Fail Forward feature, refer to the Admin Console --> IP Endpoints --> 
Options 1 tab 

* The amount time it takes for the IP Endpoints to appear on the Operator Console varies based on the
model and configuration.  The ii3 Endpoints try to reconnect to the Primary Server for 120 seconds before
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failing forward.  The IP7 Endpoints can be configured to attempt  to reconnect to the Primary Server for 5 
to 90 seconds before failing forward. 
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Logon 

When Operator Console is started, the Logon dialog is displayed: 

 Logon ID -Operator ID as configured in the Admin Console --> Operators tab.

 Password - Enter the corresponding Operator's password. This field is case sensitive.

Please Note - an Operator can only be logged on to a single Console at a time unless the
Allow Multiple Logons option in the Admin Console --> Operators tab has been selected. 

 Login button - Click to process the login information.

 Cancel button - Click to cancel the logon operation and close the Operator Console.

 Options button - Click to toggle the display of the Connections information*.

 Hide Options?  - Disable Options button After Info Set - If this option is selected, the
Options button will be "grayed out" to prevent the Connection information from being
changed.  If the Connection information needs to be changed, logon to the Operator Console
as an Operator that has been defined with the Administrator Rights option in the Admin
Console --> Operators tab, then select menu option Preferences --> Connections.

 Connections

 Address - (required) Enter the IP Address or DNS of the Primary TalkMaster FOCUS
Server.  Once the Address has been entered, the Logon Options will not be displayed.
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 Fail Forward 1 - (optional) Enter the IP Address or DNS of the first Fail Forward
TalkMaster FOCUS Server.

 Fail Forward 2 - (optional) Enter the IP Address or DNS of the second Fail Forward
TalkMaster FOCUS Server.

 Fail Forward 3 - (optional) Enter the IP Address or DNS of the third Fail Forward
TalkMaster FOCUS Server.

 Automatic Return to Primary - Check this box to have the Operator Console
automatically determine when the Primary TalkMaster FOCUS Server is available and
reconnect to it. The Operator Console will wait 60 seconds before attempting to return
to the Primary Server.

Please Note - the Fail Forward Server should have the same configuration as the
Primary TalkMaster FOCUS Server.  Refer to the Admin Console --> File menu for 
information on Exporting the Primary Servers configuration and Importing it to the Fail 
Forward Server(s).    

 Use UPD/RTP - Check this box to send/receive audio to/from the Server using the RTP
Protocol instead of the TCP Protocol (TCP is always used to send and receive commands
to/from the Server).  This reduces audio lag on the network.  If there is a NAT'd router between
this Operator Console and the Server, RTP will not work unless a fixed RTP port is specified
and the appropriate Firewall port is opened up.  If this option is unchecked, the Console will
only use the TCP Protocol when communicating  with the Server. The protocol that is in use is
displayed in the lower right hand corner of the main display.

 Fixed RTP Port - Used to specify a fixed RTP Port for the Operator Console.  If no port is
specified, UDP Port 23010 will be used. If 23010 is not available, the port will be incremented
until a free port is found.

Please Note - The use of UDP/RTP is required if using Full Duplex Intercoms.  It is also
strongly recommended if the Monitoring feature is to be used. 

* The information below the Options button is automatically displayed till the Operator Console
successfully logs into the TalkMaster FOCUS Server. Press the Options button to display the information
again.
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Main Screen 
The main Screen is composed of two tabs, the Intercoms tab and the Groups tab. 

1. Intercoms/Paging Groups/ Monitoring tabs - The Intercoms tab is used for  2-way audio
communication with Intercoms as well as 1-way audio with selected Intercoms/Paging
Endpoints.  The Paging Groups tab is used for 1-way audio paging using pre-defined Paging
Groups and pre-recorded Messages. The Monitoring tab can be used to monitor (listen to)
multiple IP Endpoints at the same time.  The Paging Groups and Monitoring tabs can be
hidden by selecting menu option View --> Preferences, by selecting the Layout tab.

2. Intercom List - Lists Intercoms currently assigned to this TalkMaster FOCUS Console.  Some
columns on this tab can be hidden by selecting menu option View --> Preferences, the
selecting the Layout tab.

3. Calls Waiting List - Lists Intercom calls that are unanswered, or are in progress.

4. Message Player - Plays messages that have been recorded during an incoming call.

5. Status Bar - Displays the TalkMaster FOCUS Server IP and the number of Intercoms
connected / "total managed" by this TalkMaster FOCUS Console.

6. Listen Mode - Determines how the Listen button is activated.

7. Talk Mode - Determines which Intercoms to send audio to.
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8. Options Bar - Shows when the PTT, uLaw and RTP options are being used.

1. Paging Groups - Pre-defined paging Groups assigned to this Operator Console.

2. Paging Messages - Pre-defined paging Messages that are assigned to the selected Paging
Group. 

Status Bar 

The Status Bar is located at the bottom left hand side of the Operator Console display.  It shows: 

 The IP address of the TalkMaster FOCUS Server the Operator Console is connected to.

 The number of Intercoms/Paging Endpoints that are currently connected  (have a status of
Connected or in use).

 The number of Intercoms/Paging Endpoints managed by this Operator.
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Options Bar 

The Options Bar shows which options are in affect for this Operator Console. 

PTT - Indicates that the Talk button must held down with the mouse (or the Space Bar on the keyboard 
must be held down) while speaking into the microphone.  If this option is grayed out, clicking the Talk 
button once (or pressing the Space Bar on the keyboard once) will toggle the state of the Talk button. 
This option is specified in Preferences. 

uLaw - Indicates that audio sent from the microphone will be sent in uLaw. 

RTP/TCP - Indicates the protocol that is being used to transfer audio between the Console and Server. 
 This option is specified on the Logon dialog. 

Monitored Video Screen 

The Monitored Video Screen is available when the TalkMaster FOCUS License includes the Video option. 
 The Monitored Video window is configured using menu option View --> Monitored Video 

Associated Video Screen 

The Associated Video Screen is available when the TalkMaster FOCUS License includes the Video 
option. The Associated Video window is configured using menu option View --> Monitored Video  
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Using the Intercoms Tab 

Intercoms Tab 

The Intercoms Tab enables an Operator  to carry on 2-way audio communications with an Intercom. The 
Operator can also send 1-way audio to a manually selected group of Intercoms/Paging Endpoints. 

Select menu option View --> Preferences, then select the Layout tab to change the columns displayed 
on the Intercoms tab. 

Review the following topics for an overview of how to use the Intercoms tab: 

How to answer an incoming half duplex Intercom call 

How to initiate an outgoing half duplex Intercom call 

How to answer an incoming full duplex Intercom call 

Intercom List 

The Intercom List shows all of the Intercoms that are currently being monitored. 
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 Grp - Please Note that the capabilities associated with this option have been deprecated.  To
re-enable the ability to select a group of IP Endpoints, follow the instructions found under View -
-> Preferences--> Layout for Show Deprecated Options.  Checking this box and setting Talk
Mode to Group allows multiple Intercoms to be included in the Talk, Chime or Play File
operation (only one Intercom can be listened to at a time). Multiple rows can be selected by
clicking on a Location name, then holding the Shift key and clicking the Location name in
another row. Select/Unselect all rows by clicking the Grp column header.

 Location - Identifies the IP Endpoint by its friendly Name.

 Queue - Identifies the Queue that the Intercom is assigned to.

 Status - Identifies whether the Intercom is currently available or in use.

 Door/Gate - When the   ICON is present, the Intercom's Door/Gate Relay can be
activated by clicking the ICON. The relay is activated for the number of seconds defined in the
Intercom settings.

If the IP7 Sensor is connected to a door open monitor switch: 

o If the Door/Gate ICON is pressed, the ICON will change to yellow as long as 
the door is opened.

o If the Door/Gate ICON has not been pressed, the ICON changes to red as 
long as the door is opened.

 IP Address - Displays the IP Endpoint's current IP Address.

 Music - If the IP Endpoint supports the Background Music feature, click the ICON to toggle the
feature on/off.  This causes the Endpoint to "reboot" with its new configuration.

 Monitored - If the IP Endpoint supports the Monitoring (listen to) feature, click the monitor ICON
under the Monitored column for each IP7 that is to be monitored.  Refer to the Monitoring
Overview for more information.  If the IP7 Endpoint is currently playing background music, it will
be suspended until the monitoring operation is ended.

 Sound Level - The Sound Level Meter graphically displays the microphone volume of the
Endpoint being monitored.  Click on the Sound Level Meter to reset the level to zero.  Click on
the Sound Level column header to reset all sound levels to zero.

 Mute - If an Endpoint is being monitored, click the mute ICON to toggle on/off muting for this
Endpoint. If a monitored Endpoint is muted, it continues to send audio to the Operator Console
and update the Sound Level meter, but the audio is not heard on the audio card used for
Monitoring.  Click on the Mute column header to mute/unmute all monitored Endpoints.

Right clicking on an IP Endpoint displays the ICOM ID and the Firmware revision of the Intercom. 
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When Talk Mode is set to Selected, the currently selected Intercom is highlighted with a blue 
background. 

Intercoms can be dynamically "added to" and "removed from" the Intercom List based upon Queue 
Overflows. 

Clicking on the Location, Queue, Status, Door/Gate, IP Address, Music or Monitored column headers 
will sort the list by that field. 

Calls Waiting List 

The Calls Waiting List shows a list of incoming calls. The list is automatically sorted into Priority 
sequence, with the highest priority Intercom listed first. As soon as Talk or Listen is selected for a call in 
the Calls Waiting List, it is removed from the Calls Waiting List in all other Consoles that are assigned to 
that Intercom. 

The columns definitions are: 

 Sts - Identifies the Call status as an ICON.

o - Priority Intercom waiting to be answered. Intercoms appear in the list in order
of their priority.

o - Call has been answered and is currently being serviced.

o - Call has been answered by this Console and is on Hold.

o - Call is in overflow status waiting to be answered.

o Blank - A non-priority call is waiting to be answered.

 Calls Waiting - Identifies the calling IP Endpoint by its friendly Name.

 Details - Identifies the time the call came in.

 Length - Identifies the length of a recorded message from an incoming call. The recorded
message can be played back using the Message Player.

Select one of the following options: 

 Talk/Start - Turns on PC's microphone to talk to an IP Endpoint  or starts a full duplex
conversation with an IP Endpoint.

 Listen/Mute - Turns on the PC's speaker to listen to the intercom user. For a full duplex call,
mutes the Operator's microphone.
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 End - Ends a call with an intercom user and removes it from the Calls Waiting list.

 Hold - Keeps a call available in the Calls Waiting List while another call is handled. The
Intercom Status changes to "In Use" and is unavailable to any other Operator Console until the
call is Ended.

To answer a call from the Calls Waiting List: 

 Select the IP Endpoint to communicate with by clicking on it.

 Activate Talk or Listen.

 The call is removed from the Calls Waiting List on other Consoles and the Status ICON will

change to .

 When done, click End or press the Escape key and the call is removed from the Calls Waiting
List.

To put a call on Hold: 

 Select the IP Endpoint from the Calls Waiting List to be placed on hold.

 Click the Hold button or press the Backspace key.

 The Status ICON will change to . 

 Select another inbound call from the Calls Waiting List or make an Outbound call by selecting
an IP Endpoint from the Intercom List.

To remove a call from Hold: 

 Click on the IP Endpoint (Status ICON will be ). 

 Activate the Talk, Listen, or End button.

Message Player 

Use the Message Player to playback audio that was recorded from an incoming call. 

Note: Audio can be recorded in the Calls Waiting List while the Call button is pressed if Record Audio in 
Call Queue has been checked in the Admin Console. 

 Select the call from the Calls Waiting List.

 Press the Hold button.

 Click the Play button   and the audio will begin playing. 

 The Play button changes to a Pause button  to allow the playback operation to be paused. 

 To stop the playback operation, click the Stop button . 

 To mute the playback operation, click the Mute button . 
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Listen Mode 

For half-duplex audio operations with an Intercom, Listen Mode determines if the Listen button is 
automatically turned on when the Talk button is turned off. 

When set to Automatic, the Listen button is automatically activated when the Talk button is deactivated. 
This allows the Intercom user to operate in a "hands free" mode. 

When set to Manual, the Listen button must be activated by the Operator or by pressing the Call button 
on the Intercom. 

Listen Button 

The Listen button plays half-duplex audio from the currently selected Intercom on the PC's Speakers. 

If Listen Mode is set to Automatic, the Listen button will be activated any time the Talk button is 
deactivated. 

The Listen button is red when not active  and green when it is active 

There is a VU meter under the button that shows relative level of incoming audio. As the audio level 
increases the VU Meter extends to the right going from green to yellow to red. 

The Listen button can be activated by the Operator by: 

 Single clicking the Listen button with the mouse. OR

 Pressing the "L" key on the keyboard.

Only one Intercom can be listened to at a time. 

Release Button 

The Release button replaces the Listen button when an Intercom/Paging Endpoint is configured with the 
Remote Listen Disable option. The Remote Listen Disable option prevents the Operator Console from 
"listening in" on an Intercom without the Intercom User's knowledge. In this mode, the Intercom User must 
press the Intercom's Talk button when responding to the Operator Console. Please see the Sample 
"Remote Listen Disable" Session for details. 

The Release button is inactive  until an Intercom is selected and the Talk button is pressed. 

 When the Talk button is released the Release button becomes active . 

Talk Mode 
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The Talk Mode radio buttons have been deprecated as of V5.2.1.  They can be re-enabled checking 
the Show Deprecated Options box in menu option View --> Preferences --> Layout  

The Talk Mode setting determines which Intercom(s) will be used in audio operations with the Operator 
Console. 

 Selected - 2-way intercom audio is sent to / received from the intercom currently highlighted in
blue in the Intercom List using the TALK and LISTEN buttons.

 Group - 1-way paging audio is sent to any intercom that has a check mark in the Grp column of
the Intercom List.

 All Active - 1-way paging audio is sent to all  intercoms in the Intercom List.

Switching from Selected to either Group or All Active automatically disables the  Listen button. Refer to 
the Monitoring feature for listening to multiple Intercoms.  

When using Group or All Active mode, 1-way audio is sent to the intercoms using the network protocol 
selected in the Admin Console --> Setup --> Paging Method tab. 

Play File - Opens the File dialog to allow selection of pre-recorded wav files to be sent to the Intercom(s) 
identified by the Talk Mode. Play File changes to Stop File while a file is being sent to one or more 
intercoms. An audio file can be terminated by clicking Stop File.  Refer to the Paging Groups tab to use 
the Paging Groups and Messages configured using the Admin Console. 

To play a .wav file on the Intercom(s), audio files must be encoded in either 8khz 8 bit PCM or 16 bit 
uLaw format. 3rd party software. 

Chime - A recording of four successive beeps is sent to the Intercom(s) identified by the Talk Mode.  This 
feature is typically used to announce a call to an Intercom from Operator Console or to test an 
Intercom(s) speaker. 

Talk - Will turn on the PC's microphone to send the audio to the Intercom(s) identified by the Talk Mode. 

Talk Button 

The Talk button turns on the PC's microphone to send half-duplex audio to one or more IP Endpoints 
selected in the Intercom List. When a single Intercom is selected, a 2-way half-duplex conversion can be 
carried on.  If multiple IP Endpoints are selected, a 1-way audio page can be sent.  

The Talk button is red when not active  and green when it is active . 
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There is a VU meter under the button that shows relative level of outgoing audio. As the audio level 
increases the VU Meter extends to the right going from green to yellow to red. 

By default, the Talk button is activated by: 

 Clicking and holding the mouse on the Talk button. OR

 Pressing and holding the Space Bar.

By un-checking the Hold down Talk button while speaking (PTT) box in menu option View - 
Preferences, the Talk button can be toggled by: 

 Single clicking the Talk button with the mouse. OR

 Tapping the space bar.

Call Button 

The Call button replaces the Talk button when the HS-x1 Handset is installed on an Intercom. 

If no call is in progress, clicking on the Call button  will initiate a call to the Intercom. A ring 
tone will be heard in the Operator Console and on the Handset till the Handset is picked up or the 

Operator presses the End button  or selects a different Intercom. Once the Intercom is picked 
up, the Operator Console's Listen button will be activated and the End button will be changed to a Talk 
button. 

Refer to the Talk button topic for additional information. 

Start Button 

The Start button starts a full duplex audio session between the Operator and the IP Endpoint selected in 
the Intercom List. The Start button appears whenever the selected IP Endpoint is configured with the Full 
Duplex option. 

The Start button is red when not active  and green when it is active . 

There is a VU meter under the button that shows relative level of outgoing audio. As the audio level 
increases the VU Meter extends to the right going from green to yellow to red. 

The Start button is activated by: 

 Clicking the Start button. OR

 Pressing the Space Bar.
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The Start button changes to the Stop button when activated. To deactivate: 

 Clicking the Stop button. OR

 Press the Space Bar.

When stopped, If the call was initiated by the Console Operator, the call is terminated.  If the call was 
initiated by the IP Endpoint, the call is automatically placed on Hold. 

Mute Button 

The Mute button is used to mute the Operator's microphone during a full duplex audio session with an IP 
Endpoint. This allows the Operator to temporarily change the session to "listen only".  

The Mute button is displayed when a full duplex call is in session  and if activated, 

changes to Unmute . 

There is a VU meter under the button that shows relative level of incoming audio. As the audio level 
increases the VU Meter extends to the right going from green to yellow to red. 

The Mute button is activated by: 

 Clicking the Mute button. OR

 Pressing the Space Bar.

The Start button changes to the Stop button when activated. To deactivate: 

 Clicking the Stop button. OR

 Press the "s" key on the keyboard.

IP Endpoint Volume Control 

To display the IP Endpoint Volume Controls, select menu option View  Preferences, select the Audio 
and Volume tab and check the Setup Volume check box. This menu option only appears for Operators 
defined in the Admin Console with the Administrator Rights option. 

The volume controls are displayed to set the volume of each IP Endpoint to its desired volume after the 
system has been installed. Please note that the Calls Waiting list is hidden while the IP Endpoint Volume 
Controls are displayed. 

Volume can be set for an Intercom/Paging Endpoint, for a group of Intercoms/Paging Endpoints or for all 
Active devices. 

 To set the volume for an individual device, set the Talk Mode to Selected and highlight a
device in the Intercom list.

 To set the volume for a group of devices, set the Talk Mode to Group and check the GRP box
next to the desired devices in the Intercom list.
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 To set the volume for all devices, set the Talk Mode to All Active.

Set Volume - Select one of the seven audio levels from the drop down list and then press the Set 
Volume button. The endpoint(s) identified by the current Talk Mode will be set to the selected volume 
setting.  The Get Volume button must be used before setting the volume for a single IP Endpoint.  

Get Volume - If Talk Mode is set to Selected, pressing the Get Volume button will retrieve the current 
volume setting for the highlighted device. 

Test Volume - Pressing the Test Volume button begins playing a pre-recorded audio file that is defined 
in the Audio and Volume tab of the View  Preferences dialog. The Test Volume button changes to 
Stop Test, and the file will continue to be sent to the selected endpoint(s) until the Stop Test button is 
pressed. Volume cannot be changed while audio is being sent to the endpoint(s). 

To remove the Intercom Volume Controls, select menu option "View  Preferences", select the Audio 
and Volume tab and uncheck the Setup Volume check box. Stopping and restarting the Operator 
Console will also remove the Intercom Volume Controls from the main dialog. 

Incoming Call 

The Incoming Call dialog is displayed when an Intercom Users presses the Call button and the 
Preference Activate Call Announcement has been checked. 

Clicking Answer Now  or pressing the Enter key will close this dialog and bring up the main Operator 
Console screen. 

Clicking Answer Later will close this dialog and will silence the Audible alert for 30 seconds. 

The Keyboard can be disabled for this dialog by selecting menu option View --> Preferences and 
checking the Disable keyboard interface on Call Announce dialog 
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Duplex Options 

Digital Acoustics' supports several levels of audio duplexing options between Operator Consoles and IP 
Endpoints.  

 Full Duplex - both the Console Operator and the Intercom user can speak "hands free" at the
same time.  Based on the volume of the IP7's Speaker and its proximity to the IP7's Microphone,
the IP7's microphone may be muted if the Console Operator is speaking.  Once the Console
Operator stops talking, the Intercom user can speak

 Half Duplex - the Console Operator can speak when the TALK button is activated in the
software. When the TALK button is deactivated, the Intercom user can speak "hands free"

 Push-to-Talk Half-Duplex - the Console Operator can speak when the TALK button is activated
in the software. When the TALK button is deactivated, the Intercom user can press the Intercom's
TALK switch to speak

For the Full Duplex, specific hardware is required: 

 The IP Endpoint must be an IP7 with a handset or an IP Endpoint with Acoustic Echo Cancelling
(AEC) hardware feature.(Such as the IP7-FD or IP7-FX)

 The Operator Console must use a handset, headset or a Windows Audio Device that supports
Acoustic Echo Cancelling or a headset

Sample Full-Duplex Session 

Below is a sample full duplex audio session that is initiated by the Intercom User. The Console Operator 
User answers the call and both parities are able to speek "hands free".  The IP Endpoint must be 
configured for full duplex. 

 A user presses the Talk button on an Intercom.

 At the Operator Console, the incoming call is placed in the Calls Waiting List.

 The Incoming Call dialog opens to announce the call.

 The Operator presses the Start button.
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 Both the Operator and Intercom User are able to speak hands free.  Depending on the
proximity and volume of the Intercom's speaker and microphone, the conversation can be
either Full-Duplex or Hands Free Duplex.

 The Operator's microphone can be muted by toggling the MUTE button.

 To end the conversation with the Intercom, the Operator presses the Escape key on the
keyboard or clicks the End button in the software.

Sample Half-Duplex Session 

Below is a sample half-duplex session that is initiated by a User pressing an Intercom's Talk button. 

The following example assumes the Preference Hold down Talk button while speaking (PTT) has been 
set. 

 A user presses the Talk button on an Intercom.

 At the Operator Console, the incoming call is placed in the Calls Waiting List.

 The Incoming Call dialog opens to announce the call.

 The Operator presses the Answer Call Now button.
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 The Operator presses and holds down the Space Bar to active the Talk button and speaks to
the Intercom User.

 The Operator releases the Space Bar and Listen is automatically turned on.

 The user at the Intercom is able to respond "hands free".

 Each time the Operator holds down the Space Bar, the Talk button is activated. When the
Space Bar is released, the Talk button is turned off and the Listen button is engaged.

 To end the conversation with an Intercom, the Operator presses the Escape key on the
keyboard or clicks the End button in the software.

Sample "Remote Listen Disable" Session 
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Below is a sample session that is initiated by a User pressing an Intercom Talk button on an Intercom 
that has the Remote Listen Disable option set. The Remote Listen Disable option prevents the 
Operator Console from "listening in" to an Intercom unless the Talk button on the Intercom is pressed. 

The following example assumes the Preference Hold down Talk button while speaking (PTT) has been 
set and the Intercom has been configured with the Remote Listen Disable option. 

 The user presses the Talk button on an Intercom.

 At the Operator Console, the incoming call is placed in the Calls Waiting List.

 The Incoming Call dialog opens to announce the call.

 The Operator presses the Answer Now button.

 The Operator establishes a "call session" by pressing and holding the Space Bar to activate
the Talk and Release buttons available.

 The Operator speaks to the Intercom user while holding down the Space Bar.

 The Operator releases the Space Bar to stop talking.  The Intercom user presses the Talk
switch on the IP Endpoint to respond.
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 The Intercom User releases the Talk button on the IP Endpoint.

 Each time the Operator holds down the Space Bar, the Talk button is activated. When the
Space Bar is released, the Talk button is turned off.

 The Intercom user must press the Push to Talk button on the Intercom to talk to the Operator.

 The Intercom's status will be set to In Use until the call session is ended.

 To end the call session, the Operator must press the Escape key, or click the End button in
the software.

Keyboard Shortcuts 

The following Keyboard shortcut can be used in Operator Console: 

 Talk button = Press and hold Spacebar or tap the Space Bar depending on the Preference
Hold down Talk button while speaking (PTT)

 Listen button = "L" key

 End button = Escape key

 Hold button = Backspace key (only applies to calls in the Calls Waiting list)

 Door Open Icon = Enter key

 Open the Search dialog = ctrl+f
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Using the Paging Groups tab 

Paging Groups tab 

The Paging Groups tab enables an Operator to send live or pre-recorded audio Messages to pre-defined 
Groups of Intercoms/Paging Endpoints. 

Review the following topics for an overview of how to use the Paging Groups tab: 

How to send a pre-recorded message to a Group of Intercoms/Paging Endpoints 

How to send microphone audio to a Group of Intercoms/Paging Endpoints 

Using Paging Groups 

The Paging Groups assigned to the Operator are listed on the left hand side of the screen. 
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Grp - The Grp column is used to select multiple Groups to send an audio page to.  To select more than 
one Group, click on the Grp column for each Group to be selected.  Clicking anywhere else on the 
screen clears all check marks in this column.   

Sts - The Sts column is a visual indicator of the connection status of the Intercoms/Paging Endpoints 
within the Group. 

 The ICON shows that all Intercoms/Paging Endpoints are connected to the Server. 

 The  ICON shows that one or more Intercoms/Paging Endpoints are disconnected from the 
Server.

 The  ICON shows that all Intercoms/Paging Endpoints are disconnected from the Server. 

Q - A "Q" in this column indicates that the Paging Group is defined as a Queued Group.  For pre-recorded 
Messages, the message is played when some or all of the IP Endpoints in the Paging Group are available 
(based on the delivery option of the Paging Group). For messages sent through the Operator Console's 
microphone, the audio is recorded, then played when some or all of the IP Endpoints in the Paging Group 
are available (based on the delivery option of the Paging Group). 

Group Name - The name of the Group as defined in the Admin Console.  To select a single Group, click 
on the Group Name. This will clear any check marks in the Grp column. 

To see the Intercoms/Paging Endpoints in the Group, right click on it. 

Once one or more Groups have been selected, a Message may be selected to send a pre-recorded 
Message or the Talk button may be engaged to send audio via the PC's microphone. 

Messages 

The Messages assigned to the selected Group(s) are displayed on the left hand side of the screen.  If 
multiple Groups have been selected, only those Messages common to all of the selected Groups are 
displayed. 
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Priority - The Priority column give a visual indicator of the priority of the Message.  Clicking the Priority 
column header will sort the messages by priority order. 

R - The R column indicates that once the message is started, it will repeat till the Operator presses the 
Stop File button. 

Message Title - The Message Title column lists the Message name defined in the in the Admin Console. 
Clicking on the Message Title column header will sort the Messages by their name. 

Once the Message has been selected, pressing the Play File button will send or queue the Message to 
be sent. 
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Sample Paging Session using a Pre-Recorded Message 

The following is an example of sending a pre-recorded Message to a Group of Intercoms/Paging 
Endpoints: 

 The Operator selects the Group tab at the top of the Operator Console screen. 

 From the left side of the screen, the Operator selects a Group by clicking on the Group Name. 

 The associated pre-recorded Messages for that Group are displayed on the right hand side of the 
screen. 

 The Operator selects a Message by clicking on the Message name. 

 The Operator presses the Play File button. 

 The Play File button changes to Stop File and the File is sent to the group(s). 

 

 The Operator can end the Message by pressing the Stop File button at any time. 

 When the Message has finished playing, the Stop File button changes back to Play File. If the 
pre-recorded Message has been configured to repeat, the Operator must press the Stop File 
button to end the Message. 

To select multiple Groups: 

 The Operator selects the Group tab at the top of the Operator Console screen. 
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 From the left side of the screen, the Operator selects a Group by clicking on the Grp column for
each group.

 The associated pre-recorded Messages for those Groups are combined and only those common
to the selected Groups are displayed on the right hand side of the screen.

 The Operator selects a Message by clicking on the Message name.

 The Operator presses the Play File button.

 The Play File button changes to Stop File and the file is played to the group(s).

 The Operator can end the Message by pressing the Stop File button at any time.

 When the Message has finished playing, the Stop File button changes back to Play File. If the
pre-recorded Message has been configured to repeat, the Operator must press the Stop File
button to end the Message.

Sample Paging Session using Microphone Audio 

 The Operator selects the Group tab at the top of the Operator Console screen.

 From the left side of the screen, the Operator selects one or more Groups by clicking on the Grp
column for each group.

 The Operator engages the Talk button by pressing and holding the Space Bar on the keyboard
and begins speaking.  The microphone audio is either streamed to the group(s) or recorded and
queued.

 When the Operator is done speaking, the Space Bar is released.



Using the Paging Groups tab 

33 



34 

Monitoring multiple Endpoints 

Monitoring Overview 

TalkMaster FOCUS Operator Console, in conjunction with TalkMaster FOCUS Server, supports to the 
ability to monitor (listen to) the audio from multiple IP7 Intercoms at the same time. Monitoring is not 
available on the ii3 series IP Intercoms. 

Monitored Audio is NOT recorded by the TalkMaster FOCUS Server 

Monitoring is a low priority operation on the IP7.  The following normal audio operations will interrupt a 
monitoring session: 

 Initiating a call from the IP7 to a Console by pressing the TALK button on the IP7.

 Initiating a call with the IP7 from a Console.

 Initiating a 1-way audio page from a Console to the IP7 by pressing the TALK, CHIME or PLAY
FILE button.

 Initiating a call from the IP7 to a SIP Extension by pressing the TALK or LISTEN button on the
IP7.

 Initiating a call from a SIP system to the IP7.

The IP7 resumes monitoring once the audio operation has completed.   

The only audio operation that Monitoring will interrupt is an IP7 playing Background Music. 

Monitoring is NOT an exclusive operation.  Multiple Operator Consoles can monitor the same IP7 at the 
same time.  The TalkMaster FOCUS Server will receive the audio from the IP7 Intercom and will forward 
that audio to each Console that is monitoring it. 

To aid the Operator in determining which IP7 the audio is originating from: 

 The Audio from the monitored devices is mixed into a single audio stream for each Operator
Console.

 A Sound Level meter is displayed for each device.

 The Operator can mute the audio from one or more devices.

 Multiple audio cards can be used by the Operator Console.

Monitored audio that is being received by the Operator Console from multiple IP7s is mixed together by 
"averaging" the audio into a single stream for the Operator's audio comfort.  The volume of the mixed 
audio is typically quieter than the audio from a single IP7.   

The Sound Level meter shows the current volume level, the ten second moving average and the Max 
volume level that has been reached.    

The TalkMaster FOCUS Operator can mute the audio from one or more of the monitored devices. The 
Sound Level meter continues to be updated while the audio is muted. 

The Operator Console can be configured to use a separate audio card in the PC to play the monitored 
audio or the same audio card can be used for both "normal" and monitored audio operations.  If the same 
audio card is being used for both, the monitored audio is automatically muted when the Operator starts a 
"normal" audio operation. If a different audio card is specified, the monitored audio will continue to be 
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played while the Operator engages in "normal" audio operations. In either case, the Sound Level meters 
for the monitored devices will continue to be updated. 
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Monitoring on the Intercoms tab 

The Operator Console can listen to multiple IP7 Endpoints at the same time by using the Monitoring 
feature. 

  

 

To setup monitoring in the Operator Console: 

 Select menu option View --> Preferences, then click the Audio and Volume tab. 

 Select the Audio Card to be used to play the monitored audio on. 

 Select the Layout tab.  Make sure the following columns are selected: 

 Monitor Indicator 

 Sound Level 

 Mute Indicator 

 Close the Preferences. 

On the Intercoms tab: 

 Click the monitor ICON under the Monitored column for each IP7 that is to be monitored.  If the 
IP7 Endpoint is currently playing background music, it will be suspended till the monitoring 
operation is ended. 

 The monitored audio is played on the Audio Card specified in the Audio and Volume tab of the 
Preferences. 

 The Sound Level meter graphically displays the sound level coming from the IP7 Endpoint. 

 The Operator Console can perform any other operation while monitoring is active such as: 

 Listen to a specific Endpoint 

 Receive incoming calls 

 Make outgoing calls  

 Send a message to a Paging Group 

 If a monitored Endpoint is involved in any other audio operation (other than playing background 
music), monitoring for that endpoint will be suspended till the other audio operation is complete. 



Monitoring multiple Endpoints 

37 

 To mute an Endpoint, click the mute ICON under the Mute column. If a monitored Endpoint is
muted, it continues to send audio to the Operator Console and update the Sound Level meter,
but the audio is not heard on the audio card used for Monitoring.

 If the Operator Console is closed while monitoring one or more IP7s, monitoring will automatically
resume on the same Endpoints when the Operator Console is started again.

Monitoring on the Monitored tab 

The display of the Monitored tab is a configurable option.  Select menu option View --> Preferences, 
then select the Layout tab and place a check next to the Monitor Tab option. 

 The Monitored tab makes it easier to view the Sound Level meters when a large number of
Endpoints appear on the Intercoms tab, but only a few of them are being monitored. Only the
IP7s that are currently being monitored will appear on this tab.

 The only audio operation that can be performed on this tab is to mute or unmute an endpoint.  A
muted Endpoint continues to send audio to the Operator Console and update the Sound Level
meter.

 If any other operation is to be performed, highlight the Endpoint, then switch to the Intercoms
tab.
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Menu Options 

File Menu 

The File Menu has the following options: 

 Logoff - Will logoff the current Operator and open the Logon dialog.

 Exit - Will end the Operator Console program.

Search Menu 

The Search menu has the following option: 

 Search IP Endpoint List - opens the Search IP Endpoint List dialog to search IP Endpoints by
any part of the Location Name, ICOM ID or IP Address

 This will search for a match within the IP Endpoint's Location Name, IP Address and
ICOM ID (even if the field is not displayed in the list box)

 The search will automatically wrap when it reaches the end of the list

 Enter the string to search for and click either the FIND PREV or FIND NEXT button

 The dialog can stay open and be repositioned while other tabs are selected

 A history of previous searches made can be selected from the Find what: drop down
arrow

View Menu 

The View Menu has the following options: 

 Screen Position - Allows the Operator Console and the Video windows sizes and positions to
be saved or to be reset it to the default size and position.

 Preferences - Opens the Preferences window. This menu option is only displayed if the
Operator is defined with the Administrator Rights option in the Admin Console -->
Operators tab.

 Monitored Video - Allows the adjustment and setting for monitored video screens and setup.

Preferences - Main 

The Preferences dialog configures the way Operator Console will behave for the current Windows user 
that has logged on to this computer. 

The Preferences menu only appears if the Operator is defined with Administrator Rights in the Admin 
Console. 

Main tab 
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Minimize to System Tray on Close (X) - Checking this option will cause Operator Console to be 

minimized to the Windows system tray  when the X in the upper right hand corner of the screen is 
selected. Use menu option "File  Exit" to close Operator Console. 

Hold down Talk button while speaking (PTT) - The Talk button is activated by pressing and holding 
down the Space Bar or by clicking on the Talk button and holding the mouse button down. PTT displays 
in the Options bar in the lower right hand corner of the Operator Console screen. 

If this option is not checked, the Talk button is activated / deactivated by single clicking the Talk button or 
tapping the Space Bar on the computer keyboard. 

Activate Call Announcement - This option brings up the Incoming Call dialog when a call arrives in the 
Calls Waiting List. This action can be delayed by altering the Call Announcement Rules below. 

Disable keyboard interface on Call Announce dialog - Check this option to force the Operator to use 
the Mouse to acknowledge the Incoming Call dialog.  Selecting this option prevents Operators from 
accidently answering calls while entering data through the keyboard. 

Call Announcement Notification 

 Visual Notification - Causes the Operator Console title bar and task bar icon to flash. 

 Audible Notification - Causes the selected audio file to be played at the Operator Console at 
5 second intervals till the Incoming Call dialog is acknowledged. Select the Door Bell or the 
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Custom option from the list. If Custom is selected, record a file named 
custom_announcement.wav in the iSupport subdirectory of the Operator Console program 
directory. If you record a new wave file, it should only be one or two seconds long since the 
wav file will not be interrupted once it starts playing! 

Call Announcement Rules - The Call Announcement rules determine when the Call Announcement 
Notifications will be sent. 

 Queue Age >= - After the oldest call in the Calls Waiting list has been waiting for this amount
of time.

 Queue Size >= - After the number of calls in the Calls Waiting List has reached this value.

If both Queue Age and Queue Size are specified, both must be true before Call Announcement will be 
activated. 

Preferences - Audio and Volume 

The Preferences - Audio and Volume tab determines the PC audio devices to be used, the audio format 
used on the Intercoms/Paging Endpoints and allows the Intercom Volume Controls to be used on the 
main dialog. 

The Preferences menu only appears if the Operator is defined with Administrative Rights in the Admin 
Console. 

Audio and Volume Tab: 
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Wave Output Device - Select the speaker or headphone device to be used to listen to the IP Endpoints. 

Wave Input Device - Select the microphone device to be used to talk to an IP Endpoint. 

Wave Announce Device - Select the speaker or headphone device to be used to play the Incoming Call 
announcement.  

Monitor Playback Device - Select the speaker or headphone device to be used to listen to Monitored IP 
Endpoints. 

Setup Volume - Select this box to display the IP Endpoint Volume Control on the main dialog. 

Sound Level Sensitivity - Entering a value in this box adjusts the sensitivity of the MAX value in the 
Sound Level Meter.  If the Sound Level Meter is hitting the MAX value too frequently, adjust this value to 
adjust the amount of time it takes to set the MAX. Generally, this value is set between 8 and 16. 

Audio Test File - Enter the name of a pre-recorded audio file to be used for testing in the IP Endpoint 
Volume Control. The file should be a .wav in uLaw format with a sample rate of 8kHz. 

Preferences - Layout 

The Preferences - -> Layout dialog determines the fields and tabs that will be displayed in the Operator 
Console. 
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Show Columns - Place a check next to the columns that should be displayed on the Intercoms tab. 

 Queue - Display the name of the Queue the IP Endpoint is a member of.

 Status - Display the Status of the Endpoint (Connected, Disconnected, Talking, Listening, etc).

 Door/Gate - Display the ICON used for activating the IP Endpoint's onboard Relay to open a
door.

 IP Address  -  Display the IP Address of the IP Endpoint.

 Background Music Indicator - Display the Background Music indicator of the IP Endpoint.  If the
IP Endpoint supports Background Music, click the ICON to toggle on/off  the Background Music
option.
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 Monitored Device Indicator - Display the Monitored Device indicator of the IP Endpoint.  If the
IP Endpoint supports Monitoring, click the ICON to toggle on/off the Monitoring option.

 Sound Level - Display the Sound Level for Monitored Endpoints. If the IP Endpoint is being
Monoitored, the Sound Level displays the current, last 10 second average and max volume level
for this IP Endpoint.

 Mute - Display the Monitor Mute ICON for Monitored Endpoints.  When Endpoints are being
monitored, the audio for individual endpoints can be muted.  The Monitor Sound Level will
continue to be updated when a monitored Endpoint is muted.

Show Tabs 

 Groups tab - Display the Paging Groups tab.

 Monitor tab - Display the Monitor tab.

Show Deprecated Options - As of version 5.2.1, the Play File button and the Group and All Active 
options under Talk Mode on the main screen have been deprecated and are disabled by default. Select 
this option to enable the options again.  Users are encouraged to use Paging Groups in place of 
selecting a group of IP Endpoints and server based Messages instead playing local audio files. 

Preferences - Connections 

The Preferences --> Connections Tab determines the Primary and Fail Forward TalkMaster FOCUS 
Servers as well as the type of connection with the selected TalkMaster FOCUS Server.  This information 
is initially filled out from the Logon dialog on the initial connection to the TalkMaster FOCUS Server. 
 Once this information has been entered, it can be hidden from a Operator that does not have the 
Administrator Rights option. 
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 Address - (required) Enter the IP Address or DNS of the Primary TalkMaster FOCUS Server.
Once the Address has been entered, the Logon Options will not be displayed.  If this field is
set to 0.0.0.0, the Options on the Logon dialog will be displayed.

 Fail Forward 1 - (optional) Enter the IP Address or DNS of the first Fail Forward TalkMaster
FOCUS Server.

 Fail Forward 2 - (optional) Enter the IP Address or DNS of the second Fail Forward
TalkMaster FOCUS Server.

 Fail Forward 3 - (optional) Enter the IP Address or DNS of the third Fail Forward TalkMaster
FOCUS Server.

 Automatic Return to Primary - Check this box to have the Operator Console automatically
determine when the Primary TalkMaster FOCUS Server is available and reconnect to it.

 Use UPD/RTP - Check this box to send/receive audio to/from the Server using the RTP
Protocol instead of the TCP Protocol (TCP is always used to send and receive commands
to/from the Server).  This reduces audio lag on congested networks and is required if using Full
Duplex Intercoms.  If there is a NAT'd router between this Operator Console and the Server,
RTP will not work unless a fixed RTP port is specified and the appropriate Firewall port is
opened up.  If this option is unchecked, the Console will only use the TCP Protocol when
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communicating  with the Server. The protocol that is in use is displayed in the lower right hand 
corner of the main display.  

 Fixed RTP Port - Used to specify a fixed RTP Port for the Operator Console.  If no port is
specified, UDP Port 23010 will be used. If 23010 is not available, the port will be incremented
till a free port is found.

 Hide Connection Information on Logon Dialog - If this option is selected, the Options
button on the Logon dialog will be "grayed out" to prevent the Connection information from
being changed.  If the Connection information needs to be changed, logon to the Operator
Console with using an Operator that has been defined with the Administrator Rights option in
the Admin Console --> Operators tab, then select menu option Preferences -- >
Connections.
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Monitored Video 

Configure Monitored Video  - Provides the ability to configure a video window with that can be 
monitored next to the Operator Console window. The video window can display up to four cameras.  The 
cameras must be defined in the Admin Console under the IP Video Sources tab. 

How many cameras? -  Choose 1 or 4 cameras from the dropdown list to be displayed for continuous 
monitoring.  Up to four separate cameras can be specified for the display.  

Which Camera - Select a camera that has been defined in the Admin Console under the IP Video 
Sources tab 

Command - The Options refer to different settings the camera has been configured with.  For instance, 
one option may be set for 30 FPS and one for 15 FPS 

Show Monitored Video - Checking this option shows the Monitored Video Window next to the Operator 
Console window.  The Video will be displayed at all times. 

Show Associated Video - Checking this option shows the shows the Associated Video Window next to 
the Operator Console window.  The video is displayed from the time a call is answered till the time it is 
finished. 
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Tools Menu 

The Tools Menu has the following option: 

Record program events to file - Selecting this option toggles on the writing of tracking information for 
use by Digital Acoustics Technical Support. Do not select this option unless instructed to do so by Digital 
Acoustics Technical Support. 

Open Support Folder - Selecting this option opens the folder where the consoleTracking.txt file is stored. 
 This information is recorded in the "Application Data\Digital Acoustics" folder located under the 
Documents and Settings folder in the sub-directory of the currently logged in Windows user. 

Help Menu 

The Help Menu has the following options: 

 Help on using TalkMaster FOCUS - Opens the interactive Help system.

 Online documentation - Opens a web browser to the TalkMaster FOCUS Documentation
page.

 Digital Acoustics Web Site - Opens a web browser to the Digital Acoustics home page.

 About - displays the version of software.
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Support Information 

Contacting Technical Support 

For information on contacting Technical Support, please visit our web site at: 

www.digitalacoustics.com/support 

About Us 

Digital Acoustics, LLC 

www.digitalacoustics.com 

TalkMaster FOCUS®, TMEE®, ii3®, IP7® and UBAM® are trademarks of Digital Acoustics, LLC. All 
other marks used are properties of their respective owners. Digital Acoustics' product designs are 
packaged by leading manufacturers around the world. 

© 2003 -2019 Digital Acoustics, LLC 

All Rights Reserved 

https://www.digitalacoustics.com/support
https://www.digitalacoustics.com/
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